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ORD Lesson 1: Understanding the Interface and Basic Tools within 
OpenRoads 
 

Learning Objective: This lesson is intended to provide you with an introduction to the basic 2D tools, 
layouts, and functionality found within Bentley OpenRoads.  

Task 1: Creating a Design (dgn) File 

• To get started, open OpenRoads from your install location. 
• Upon opening, you will be brought to the “Main Page” below. 

 
• In this lesson, we will be using a training workspace and workset provided as part of the 

installation of the ORD software. Under the WorkSpace dropdown, select “Training and 
Examples”. Under the WorkSet dropdown, select “Training-Imperial”. 
 
 
 
 
 
 
 
 
 
 

• With the correct WorkSpace and WorkSet selected, click on the “New File” icon to create a new 
design (dgn) file. Name the file “Lesson_1” and choose a file location of your preference. Once 
Complete click “Save”. 

 

 

 

What is a WorkSpace and WorkSet? 
 
A WorkSpace defines the overall company/client drafting standards, symbologies, and 
preferences associated with your projects within OpenRoads. 
 
A WorkSet controls project-specific settings and is created on a project-to-project basis. 
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Task 2: Getting Familiar with OpenRoads Interface 

OpenRoads, like many other software products uses a “Ribbon” interface to provide quick and easy 
access to all of the tools and functions within the software. Below you will find a pictoral overview of the 
default OpenRoads user interface. 

 

 

  

 

 

 

• The File Tab provides “backstage” access within the software. Much like other software 
packages, the File Tab provides access to file settings, printing options, saving/opening files, and 
much more. 

• The Ribbon Workflow can be changed to reflect the type of work that is being performed within 
OpenRoads and will alter the tools/functions available on the ribbon for each workflow. For 
example, the Drawing workflow contains all of the tools used to draw elements within the 
software. 

• The Ribbon Tab and Ribbon Group combine and organize tools based upon their classification 
and how they are used within OpenRoads, such that they are easy to locate and readily 
available. 

Take approximately five to ten minutes to explore the user interface of OpenRoads and get familiar with 
its layout.  

 

 

Task 3: Using the mouse in OpenRoads  

• Using the mouse functions 
1. Within the Drawing Workflow, locate and select (left click) the Place Line Tool within 

the Placement ribbon group under the Home ribbon tab. 
 Left click within the workspace (black area) of the screen to start placing a line. 

Left click again to place the other end of the line. 
 Right click to exit the place line command. (Note: The “Esc” key performs the 

same function as the right click and will also exit the command) 
2. While hovering over the workspace, use the middle scroll wheel to zoom in on the line 

you just created. 

File Tab 

Ribbon 
Workflow 

Ribbon Tab 

Ribbon Group 

Important: Unless otherwise noted. All tools in this exercise can be accessed using the 
“OpenRoads Modeling” workflow. 
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3. While using the mouse to hover over the line you created, click and hold the middle 
scroll wheel and move the mouse. This action will pan across the screen. 

 

Task 4: Using Basic 2D Drawing Tools to Draw a City Tract Map  

• Using Place Line & Rotate Tools 
1. Select the Place Line Tool from the Placement ribbon group under the Home tab. Once 

selected, click anywhere within the drawing area. 
2. Create a 330’ long line by entering the information into the dialog box below. Once 

entered left click to place the line. Right click to exit the place line tool. 

 
3. Select the Fit View button to locate and center the newly placed line on the screen. 
4. From the Manipulate ribbon group select the Rotate Tool and set the dialog box to the 

values presented below. 

 
 
 
 
 
 
 
 

 

 
5. Toggle on the “Mid Point” snap from the Snap Mode tool bar located on the bottom of 

your screen, and select the mid-point of the 330’ long line drawn previously. Click again 
on the mid-point to place and store the rotated copy of the line. Your drawing should 
look like the figure below. 

How do I change the design file settings? 
 
Design file settings, such as the working units and angle readout format, can be changed 
by going to the file tab, settings, and then to design file settings. For example, here the 
angle readout can be changed from degrees, minutes, seconds to decimal degrees. The 
working units can also be changed from decimal feet to feet and inches. 
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• Using the Move Parallel Tool to create streets 
1. To create 22’ wide streets, select the Move Parallel Tool from the Manipulate ribbon 

group and enter the information in the dialog box found below. 

 

2. First, select the vertical 330’ long line. After selection, click to the right of the line to 
place a copy of the line 11’ away. Repeat for the left side and both sides of the 
horizontal line. After completion, your drawing should resemble the drawing below. 

  

• Using the Trim Multiple Tool to create curb lines 
1. Select the Trim Multiple Tool from the Modify Ribbon group. 
2. Select your cutting edge by clicking on the top horizontal line. 
3. Now, hold “Ctrl” and select the bottom horizontal line. Both the top and bottom line 

should now appear highlighted.  
4. Release the “Ctrl” key and trim the two outermost vertical lines by selecting the portion 

of those lines located between the two highlighted horizontal lines. 
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5. Repeat Steps 2 through 4, except this time trimming the outermost horizontal lines to 
create the drawing shown in the figure below. 

 

• Using the Circular Fillet Tool to create curb radii 
1. From the Modify ribbon group select the Fillet Tool. 
2. In the dialog box, set the Radius to 30’ and Truncate to “Both”. 
3. Click the first line, and then the second line that make up each curb radius. Click once 

more to save and store the fillet. 
4. Repeat steps 3 and 4 for the remaining curb radii. Once completed, your drawing should 

match the drawing below. 
 

 

 

• Using Levels to Distinguish Drawing Elements 
1. Select both the horizontal and vertical road curb lines. 
2. With the all of the curb lines selected, change the level to “Road_Curb_Edge” using the 

Attributes ribbon group, shown below: 

 

3. With the road centerlines highlighted, change the level to “Road_Centerline”.  
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4. With the two centerlines still highlighted, within the Attributes ribbon group, change the 
line style from “0” to “5”. Also change the color from color 19 (red) to color 4 (yellow). 
Your drawing should now look like the drawing below. 

 
 

5. With nothing selected, reset the active level to “Default”. 
6. Select the Line Color setting and select “By Level” in the bottom left as shown below. 

 

 
 
 
 
 
 
 
 

 
 

 

 

What are levels used for? 
 
Levels are used for many purposes which include setting the line style, line weight, and 
color of elements within a drawing. Levels can also be used to hide or show specific 
design elements with a drawing. They can also be used to determine the overall quantity 
of a specific work item, such as the total length of curb or square footage of concrete. 
pavemen  
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• Using the “Extend Line” Tool to shorten the vertical street 
1. From the Modify ribbon group, select the Extend Line Tool.  

 Note if the Extend Line Tool icon is not shown, you may need to select the drop 
down next to the Insert Vertex Tool as shown below to locate the tool. 

 

 
 

2. In the dialog box enter a distance of -30’ (note the “-“ symbol implies that the line will 
be shortened) and check the “From End” box. 

3. Select the outside end of the six vertical lines to shorten them.  

 

• Using the Mirror Tool to place adjacent streets 
1. From the drop down next to the Fence Tool located within the Selection ribbon group, 

select Place Fence. 
2. In the Place Fence tool dialog box, set “Fence Type” to Block, and “Fence Mode” to 

Overlap. Click and drag to place a fence around the entire intersection. 
3. From the Manipulate ribbon group, select the Mirror Tool. 
4. Set the Mirror Tool dialog box to the settings shown below. 

 
5. Select the end of one of the lines so that your mirrored copy connects to the original 

intersection. Click to accept the mirrored copy. 

Shorten all three lines 

Shorten all three lines 
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6. Again, using the Place Fence Tool, place a fence around the two intersections. 
7. Select the Mirror Tool and keep the settings the same as shown in step four, except now 

change the “Mirror Direction” to “Vertical”. 
8. Snap to the end of one of the horizontal lines and click to accept.  
9. Click the Fit View button. Your drawing should now look as shown below. 

 
• Use a combination of the tools described in this lesson to complete the city tract 

1. Place a fence around the streets in the upper right corner of the street grid. Ensure that 
the Fence Mode is set to “Overlap”.  

2. Use the Rotate Tool to copy and rotate the fenced streets 150 degrees. Be sure to keep 
the centerlines of the streets connected. Do not worry about connecting the curb lines 
yet. 

 

3. From the Modify ribbon group, use the Trim to Element Tool to connect the street lines 
in the lower right. First, select the line you wish to extend, then, the line you wish to 
extend to. Repeat until all lines are connected. 
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4. Use the Construct Circular Fillet Tool to fillet the connections of the streets. In the 

Construct Circular Fillet Tool settings window, set the Radius to 75’. 
5. From the Placement ribbon group, select the Place Point or Stream Curve tool to draw a 

pond (shape does not matter) in the middle block of streets. Note: You may need to 
select the drop down next to the “Place Multi-Line” Tool to locate the tool as shown in 
the figure below. 
 

 
 

6. Place the linework for the pond on the Drain _Pond level. 

 

7. Set the active attributes to the E_BNDY_Property Line level 
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8. From the Manipulate ribbon group, select the Move Parallel Tool. In the dialog box, 
turn on the Make Copy and Use Active Attributes check boxes and set the Distance to 
124’. Copy the curb lines backward to make the rear property lines as shown below. 
 

 
 

9. Use the Trim to Element Tool to extend property lines to meet the street edges. 
10. Use the Move Parallel Tool to make lots 50’ wide, and place the copied property lines 

on the E_BDNY_Property Line level. Note: The end lots of some blocks may be slightly 
larger than 50’. 

11. Use the Trim Multiple and Trim to Element Tools to extend/trim the property lines to 
match the figure below. 
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Task 5: Printing and Labeling the City Tract Drawing 

• Using the text editor to add street name labels 
1. Set the active level to “Draft_Plan_Labels” and change the level color to white. 
2. Select the Annotate ribbon tab and select the Place Text Tool found within the Text 

ribbon group.  
3. Within the text editor, set the font style to Cambria and font size to 0.025. 
4. Label the streets as shown below. Note the text dialog box shown below can be used to 

change the angle at which the text is placed. 

 

 

 

 

  

 

 

 

 

5. Copy the text for “Main Street” by using the Copy Tool found within the Manipulate 
ribbon group and place it within the open area to the right of “Park Place” street. 

6. Double click the copied text to open the text editor. Delete and replace the “Main 
Street” text with your name and today’s date as shown below. 
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• Printing the City Tract Drawing 
1. Use the Place Fence Tool around the entire city tract map.  
2. Select Print, found under the File Tab. Under the print menu, select Print. 
3. Use the print settings shown in the figure below. 
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